Uktady FPGA

— programowanie bramek w zestawie uruchomieniowym Basys3 firmy Digilent
-Srodowisko Vivado (2016.4)- firmy Xilings , jezyk Verilog

Pierwszy projektowany uktad bedzie zawierat dwie bramki logiczne, AND i OR, ktérych wejscia bedq podtqgczone do
przetgcznikow na ptytce Basys3 (oznaczone od SWO do SW15 - wykorzystamy SWO - SW3), a stan wyjs¢ bedzie
wskazywany przez diody LED (oznaczone od LDO do LD15 - wykorzystamy LDO, LD1).

1.Tworzenie projektu
e Uruchamiamy srodowisko Vivado 2016.4 (na dolnym pasku)

e Klikamy na ikone tworzenia nowego projektu ("Create New Project”). Otwiera sie okno "Create a New Vivado
Project” - Next

e W oknie Project name nazwij projekt simple_gates i wybierz jego lokalizacje jako np. Project location:
C:/Users/student. Pole Create project subdirectory pozostaw zaznaczone. -> Next

e W oknie Project type wybierz opcje ,RTL project” (Register Transfer Level) z zaznaczeniem ,,Do not specify
resource at this time” (kody Zrédtowe zostanq dodane w pdzniejszym etapie). > Next

W oknie Default part nalezy wybrac:
Product category: General Purpose
Family: Artix-7
Sub-family: Artix-7
Package: cpg236
Speed grade: -1
Temperature grade: All Remaining
Z pozostatych do wyboru zaznaczy¢ xc7a35tcpg236-1. Model ten posiada 20800 tablic LUT. - Next
e Nastepnie pojawia sie okno: "New project Summary" a w nim opisane sq parametry charakterystyczne
projektu =>Finish. Przez pare sekund tworzy sie projekt (Create project ......) i otwiera sie kolejne okno czyli

projekt: simple_gates.

e Po utworzeniu projektu, z lewej strony okna powinien znajdowac sie panel Flow Navigator. Jezeli jest on
niewidoczny, wcisnij kombinacje Ctrl+Q.
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1.Dodawanie plikéw do projektu
W panelu Flow Navigator bedziemy rozwijali zaktadke Project Manager. Utworzymy model bramki AND o nazwie

,and_gate”, ktéra posiada wyjscie ,,y” i dwa porty wejsciowe ,,a” i ,b”;
(Project Manager -> Add sources -> Add or create design sources - Next - Create File...)

Add or Create Destgn Sources =
e e S e o s s i it

+

e Pojawia sie mate okno: Create Source File

4 Create Source File [
Create a new source file and add it to your project. p
File type: 8 Verilog -
File name:
File location: | 57 <Local to Project: -
o |

e File type: Verilog, File name: and_gate, File location: - Choose location: Local to Project > OK

e Pojawia sie nowe okno z opisem i lokalizacjq projektu = Finish

e Nastepne mate okno: Define Module . Sprawdzamy Module name: and_gate i definiujemy porty (I/OPort
Definitions). Port Name/Direction kolejno: a input, b input, y output.(pole Bus zostaje niezaznaczone) - OK

4 Define Module )

W oknie Project Manager — Sources pojawia sie folder : Design Sources - plik (ve): and_gate.v ,(na dole okna
powinna byc¢ aktywna zaktadka ,,Hierarchy”.
Otwieramy go klikajgc (prawy przycisk myszy) - Open File. Pojawia sie zawartosc pliku (opis modutu): sq w
nim tylko oznaczenia wejsc i wyjs¢ - bez potqczen i funkcji

‘timescale 1Ins / 1lps

module and gate
(
input a,
input b,
output y
)7

endmodule

Uzupetnij ten kod kodu, aby wyglgdat jak ponizej: (trzeba dokonac potgczen i przypisac funkcje)
‘timescale 1Ins / 1lps

module and gate

(

input wire a, // polaczenie

input wire b,

output wire y

)z

assign y = a & b; //przypisanie ciagte, & to AND bitowy
endmodule



Zapisujemy modut (Ctrl + S). Po kazdym zapisaniu pliku Vivado analizuje kod. Jezeli sq jakies btedy sktadni, to
informacja o nich zostaje wyswietlona w zaktadce ,,Messages” okna ,,Messages”(na dole). Wygeneruj jakis btgd (np.
usun srednik na koricu komendy assign) i sprawdZ, jak wyglgda taki komunikat btedu. Zwroc¢ rowniez uwage, Ze pliki
z btedami pojawiajq sie w oknie ,Sources” w folderze , Design sources = Syntax Error Files”

e Utworz analogicznie modut bramki OR o nazwie “or_gate”. Pamietaj o symbolu OR bitowy (str 12 Verilog
Quick Reference). Po zapisaniu modutu bramki OR w folderze Design Sources sa dwa pliki: and_gate
nadrzedny (oznaczony trzema punktami jako hierarchia) oraz or_gate podrzedny. Prawidfowa hierarchia
utozy sie dopiero po skonfigurowaniu , artix7” .

e Utwdrz model catosci uktadu o nazwie ,,artix7” wedtug schematu ponizej:

4 Define Module (]
artix7
Define a module and speify 1/0 Ports to add to yeur source fle.
For each port specified:
and_gate MSB and LS8 values wil be ignored unless its Bus column is checked. [
Ports with blank names wil not be written.
. Modude Definition
e
sw[3] \ y (1 Module name: artix?
1/0 Port Definitions
sw[2]
b = Fort Name Diecton  Bus  MSB  LSB
- input - 3 0
4 led ouput  » 7 i 0
or_gate
swii] | a Y\ y| tedro
|
swio] b L/

e Jest to modut hierarchiczny: przypisanie a,b odpowiednio do sw orazy do led.

e .a(sw[1]) > . kropka oznacza strukture hierarchiczng, np: a oznacza wejscie/wyjscie (lub port) nizszego
poziomu , zawartos¢ nawiasu (sw[1]) oznacza wejscie/wyjscie (lub port) wyzszego poziomu , np. sw[1]
oznacza okreslony przetgcznik, led[0] oznacza diode.

o Utworz model catosci uktadu o nazwie ,artix7” :

‘timescale lns / 1ps

module artix7
(
input wire [3:0] sw,
output wire [1:0] led // uzupelnij analogicznie jak dla input wire ..

or gate u or gate
(
.a(swl[l]),
-b(sw[0]),
.y (led[0])
)7

and gate u_and gate // uzupeinij analogicznie jak dla or gate u or gate

endmodule

Zapisujemy modut. Teraz ustawia sie prawidtowa hierarchia w Design Sources: artix7 — modut nadrzedny i dwa
moduty podrzedne (and_gate i or_gate).

Po opracowaniu modelu obejrzyj schemat uktadu. Jezeli sq jakies btedy podczas tqgczenia projektu (elaboracji), to
nalezy je usungc. W zaktadce Sources w folderze Design Sources sq aktualne pliki zapisane hierarchicznie w postaci:

Project Manager - simple_gates

Sources _oex
Az = 2e BE

{5 Design Sources (3

{7 Simulation Sources (3
- sim_1 (3
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e  SYMULACIA: W celu przeprowadzenia symulacji potrzebujemy jeszcze minimum jednego modutu testowego,
ktory zapewni nam generacje przebiegow testowych (w folderze Simulation Sources).

e Utwdrz modut File name: ,test_simple_gates”. Project Manager ->Add Sources->Add or create simulation
sources-»Next—>Create File

4 Define Module 5
Define a module and specify 1/0 Ports to add to your source file.
Fe rt specified:
WeE 2 158 ulses il b gnored uiess s Bus ol s checked )
Ports with blank names will not be written,
Module Definition
Module name: | test_simple_gates
1/0 Port Definitions
4+ portname Directon  Bus MSB LSB
-t input ~ E 0
4 thed output v i 1 0
[cna
Okno Define Module:
Port Name: Direction: Bus: MSB: LSB:
t sw input v 3 0
t led output v 1 0

Modut ma zapewnic przetestowanie bramek dla wszystkich mozliwych konfiguracji wejs¢. Fragment kodu znajduje sie
ponizej.

W oknie Sources rozwijamy folder: sim_1 i otwieramy plik: test_simple_gates. Wpisujemy poleceniajak ponizej.
Miejsca oznaczone ....... nalezy uzupetni¢ kodem (do przetestowania pozostatych konfiguracji). Uzyj petli for (lub
repeat). Sktadnie for utworz wedtug "Verilog Quick Reference" - punkt 7.3 str. 15 (bez memory [i]=0).

‘timescale lns / 1ps
module test simple gates();

reg [3:0] t sw; // patrz Quick Ref. str 2, reg to 4-bitowy vector register
wire [1:0] t led;

artix7 DUT // DUT - Device Under Test

(
.sw (t_sw), // struktura hierarchiczna
.led(t_led)

................... // deklaracja zmiennej typu integer do iteracji (dla petli for)
initial
begin

Sdisplay ("%0t: Starting TPG.", Stime) ;

// set the inputs
#10 t sw = 4'b0000;

o // petla for patrz Quick Ref. str 15, p. 7.3
begin

#10

t sw=i; //zmienna przypisujemy do t sw

#1

if(t led == { ......... 7 DO0ODOOOD }) // wpisac¢ kolejno funkcje AND , OR dla t_sw

//wediug rysunku moduiu hierarchicznego

$display ("%0t Test PASSED for pattern $b", Stime, t sw);

else

sdisplay ("%0t Test FAILED for pattern $b - result is %b", $time, t sw, t led);
end

#10 Sdisplay("$%0t: Finished TPG.", Stime) ;
Sstop;

end
endmodule



Zapisujemy, rozwijamy foldery. Po zatadowaniu wszystkich Zrédet zaktadka , Sources” powinna wyglgdac tak:

Project Manager - simple_gates
Sources _ 0O
O 5 e e
Q= 04’7 3 E
&1 Design Sources (1
| @B arti (artix7.v) (2)
b8 u_or_gate - or_gate (or
: @ u_and_gate -and_gate
-1 Constraints
- Simulation Sources (1)
EH=sim_1 (1)
F-4B% test_simple_gates (tes
=8 DUT - artix7 (artix7. 2

8 u_or_gate - or_gate (or
B u_and_gate - and_gate
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JezZeli plik test_simple_gates znajduje sie w grupie ,, Design Sources” zamiast w ,,Simulation Sources”, nalezy klikng¢
(prawy przycisk myszy) i wybrac ,,Move to Simulation Sources”.

SYMULACIA : Uruchomienie symulacji
e Aby skonfigurowac parametry symulacji, w panelu Flow Navigator wybierz zaktadke Simulation -> Simulation

settings.

o Wybierz zaktadke Simulation/Simulation(w srodku okna). W polu xsim.simulation.runtime dopasuj
odpowiednio czas trwania pojedynczej symulacji. Pamietaj, ze nawet jeZeli ustawisz dtuzszy czas trwania
symulacji, to zostanie ona zatrzymana komendq Sstop. Jezeli ustawisz zbyt krétki, zawsze mozesz po
zatrzymaniu kontynuowac. Pole wyboru czasu trwania pozostawic¢ 1000 ns.—>0OK

4 Project Settings

Simulation
General
i Simulator language: ried =
— Simulation set: e mm_1 -
8 Simulation top module name: | test_simple_gates -
33@ Y ian top _simple_o: ]

Elaboration [#] Clean up simulation files

Synthesiz

Implementation

i)
-
z [ ok ) [ cancsl | [ apoly

e Wybierz zaktadke General. W polu Loop count ustawic "jeden" ilos¢ powtdrzeri symulacji przy pojedynczym
jej wywotaniu (UWAGA: przecinek nie jest separatorem dziesietnym!) : 0K
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e W panelu Flow Navigator wybierz zaktadke Simulation - Run Simulation ->Run Behavioral Simulation
(Przeprowadz symulacje behawioralng). Przebiegi symulacji powinny wyswietlic¢ sie na grafie zblizonym do:

e Najpierw nalezy otworzy¢ na pasku gornym zaktadke ,Untitled1” a potem rozwing¢ t sw oraz t led , a
nastepnie na pasku pionowym klikng¢ ikonke ,,Zoom fit”

Chjects —av x @ and_gate.y X | @ or_gatev X | @ artwZ.y X | @ test_smple_gates.y X | B Untitled 1 x m RS
v

A i b 68| ®

Name Value Data Tyg *

| t_sw[3:0] f Array |

|52 tled[r:0] 3 Amay |

@ i[31:0] 16 Array |

S o8 i[31:0]

W oknie po lewej zamiast ,,Sources” rozwija sie okno ,Scope”.
e Klikajgc w zaktadke Log znajdujgcg sie w dole okna programu mozna podglgdac zapisy logow:

Log -
[l |No Unisim elements were transformed
.| INFO: [Common 17-83] Releasing license: Synthesis
3, Infos, 0 Warnings, 0 Critical Warnings and 0 Errors encountered.
synth_design completed successfully
synth_design: Time (s): cpu = 00:00:08 ; elapsed = 00:00:08 . Memory (MB): peak = 487.129 ; gain = 297.363
4 write_checkpoint -noxdef andgate.dcp
4 catch [ report_utilization -file andgate_utilization_synth.rpt -pb andgate_utilization_synth.pb }
report_utilization: Time (s): cpu = 00:0 ; elapsed 00.040 . Memory (MB): pesk = 487.129 ; gain = 0.000

« B

Synthesis | Implementation  Siuiztion
/5 Td Console | © Messaged) [ Log f [ Reports | 5 Design Runs

Zaktadka Log

e Implementacja w ukladzie FPGA

e SYNTEZA: Uruchom synteze (-> Run Synthesis). Zwrd¢ uwage na pasek statusu w prawym gornym rogu ekranu.
Synteza przeksztafca opis w jezyku HDL na schemat w postaci bramek . Moze pojawic sie komunikat dotyczacy
blokady, nalezy wybrac Allow Access.

L | 4&ll<8 BrTiX/ LUl

@ Windows Security Alert 22

G Windows Firewall has blocked some features of this program

Windows Firewall has blocked some features of vivado.exe on all public and private networks,

MName:
‘ Publisher: Unknown
Path: Ciiilinx\vivado2015, 4\pinunwrappedwing4. o vivado, exe

Allow vivado.exe to communicate on these networks:

V| Private netwarks, such as my home or work netwark

Public networks, such as those in airports and coffee shops (not recommended
because these networks often have little or no security)

What are the risks of allowing a program through a firewall?

| ) Allow access | ‘ Cancel

e NaleZy sledzi¢ w prawym gérnym rogu ekranu przebieg syntezy i czeka¢ na komunikat ,,Synthesis Succesfully
Completed”. Po zakoriczeniu, na razie, nie wybieramy ,,Run Implementation” tylko ”View Reports”—>OK

e Sprawdz, ile procent dostepnych tablic LUT, buforow wejsciowych IBUF i buforéw wyjsciowych OBUF
wykorzystat na uktad (,,Reports = Utilization Raport).

e Zauwaz, Zze w menu Run Synthesis pojawity sie dwie nowe opcje (nie musisz ich teraz uruchamiac).
Aby przeprowadzi¢ implementacje sprzetowq, musimy wprowadzic¢ ograniczenie projektowe (ang. constraints), ktore
powiedzq Vivado, ktére wyprowadzenia uktadu FPGA sq uzywane i jak sq skonfigurowane.



W tym celu:

1)dodaj do projektu plik ograniczen XDC: Basys3 Master.xdc (ktdry otrzymacie od prowadzgcego) .

2)Nastepnie nalezy zapisac poprzez: Add Sources —> Add or Create Constraints ->Add Files (z projektu:
simple_gates). Odkomentuj potrzebne linijki w pliku .Nalezy odkomentowac wszystkie uzywane switche(sw 0-3) i
ledy(led0-1) po dwa wiersze na kazdy switch i led.

3)Sprawdzic czy plik xdc jest w folderze , Constraints”.

e IMPLEMENTACIA: Uruchom implementacje (,-> Run Implementation”). Obserwuj log. Po implementacji zauwaz,
ze pojawity sie nowe zestawy raportow ,Place Design” i ,Route Design”. W wiekszosci z uwagi na prostote
projektu bedg one wiekszosci puste.

e ZnajdZ w raporcie informacje o procencie wykorzystanych zasobéw 10 (Place Design->Utilization Raport,
Bonded I108B) .

e Otwodrz topografie uktadu (= Implemented Design), znajdz jedng z tablic LUT (look-up table), ktéra zostat
wykorzystana do budowy bramki AND lub OR, podswietl potgczenia wejsciowe i wyjsciowe .

e Zaznacz na topogrdfii slice i otwdrz jego schemat (prawy przycisk myszy ->Schematic lub F4). Powinien on
zawierac 4 bufory wejsciowe, dwa elementy tablicy LUT i dwa bufory wyjsciowe.

e W, Messages” mogq sie pojawic teraz ostrzezenia, ktore ignorujemy:

[Timing 38-313] There are no user specified timing constraints. Timing constraints are needed for proper timing

analysis.
[Chipscope 16-3] Cannot debug net 'led[0]'; it is not accessible from the fabric routing.(12 more like this)

e  PROGRAMOWANIE | DEBUGOWANIE: Nalezy zaznaczyc ,bin file” w Bitstream Settings. Wygeneruj bitstream
(plik zawierajgcy dane do programowania FPGA) - Generate Bitstream.

e Upewnij sie, ze przetqczniki na uktadzie Basys3 sq w odpowiednim ustawieniu (obie niebieskie zworki ”blizej
srodka” ptytki):
-JP1 (Mode) - USB
-JP2 (Power) - USB

e Podfqcz uktad Basys3 przy pomocy kabla USB do komputera i witgcz go przetgcznikiem ,,Power Switch”.
UWAGA: przed wsunieciem wtyku kabla do gniazda ptytki Basys3 UPEWNIC SIE, ze wtyk microUSB (,typ
smartfonowy”) jest prawidtowo utoZzony - wsuwamy do gniazdka ,, zgbkami do gory”.

e Skonfiguruj podtgczenie do programowania ptytki Basys3:
-Program and Debug -> Hardware Manager -> Open Target -> Open New Target ...
-Wybierz: local server, zegar programowania domysiny 15MHz

*  Program device -> xc7a35t_0

-Bitstream File powinien by¢ domysinie ustawiony poprawnie (sprawdzi¢ w okienku)
-Dostaniemy ostrzezenie, ktore w tym przypadku mozemy zignorowac:

WARNING: [Labtools 27-3123] The debug hub core was not detected at User Scan Chain 1 or 3. (Okno Messages bez
Errors).

e Sprawd?, czy uktad dziata poprawnie. Jezeli tak — gratulacje!



